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1. OVERVIEW 
 
SUDAAN is a single program consisting of a family of procedures used to analyze data from complex 
surveys and other observational and experimental studies involving cluster-correlated data.  A complete 
description of the capabilities of SUDAAN can be found at http://www.rti.org/sudaan.   
 
The following document provides instructions on how to install and run SUDAAN. The most current 
version of these installation instructions can be obtained by visiting the SUDAAN website at 
http://www.rti.org/sudaan and selecting the Downloads tab. 
 

1.1 Technical Support 
 
RTI International (Research Triangle Institute) provides limited technical support for SUDAAN problems 
free of charge. The SUDAAN Language Manual provides detailed information on programming with 
SUDAAN and the SUDAAN Example Manual provides numerous examples. Both of these manuals can 
be installed during the SUDAAN setup (as .PDF files). These manuals can also be purchased from the 
SUDAAN website at http://www.rti.org/sudaan. You may also review bug reports, get answers to 
frequently asked questions and obtain other technical assistance through our website.  
 
For additional technical support please submit a support request available from our website or send an 
email to sudaan@rti.org. 
 
You may also contact the RTI SUDAAN offices at: 

 RTI International 
 SUDAAN Coordinator 
 3040 Cornwallis Road 
 Research Triangle Park, NC  27709-2194 
 
 Voice Mail: (919) 541-6602 
 FAX: (919) 541-7431 
 Email: sudaan@rti.org 
 
Due to the high volume of telephone calls we receive, when calling the SUDAAN office you may be 
automatically sent to the SUDAAN voice mail.  Please leave your name, telephone number and a brief 
description of the reason for your call.  One of our SUDAAN administrators will contact you as soon as 
possible. 
 
SUDAAN is supplied on a CD-ROM. This media contains all versions of SUDAAN compiled and tested 
for DOS and Windows. The instructions below tell you where to find the appropriate version(s) of 
SUDAAN for your license(s). Note:  If you have licensed more than one version of SUDAAN you 
may install all licensed versions during one call to the setup.  
 

1.2 Software Installation 
 
Insert the SUDAAN CD into your CD-ROM drive and execute the program setup.exe in the root 
directory on this disk. You can do this by entering: 
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D:\setup 

 
From the Run command on the Windows Start menu. Here we assume that D: is the drive letter associated 
with your CD-ROM reader. You can also execute setup.exe by locating it in the Windows Explorer. 
Double-click on the setup.exe program icon to start the installation.  
 
The SETUP program will lead you through the installation process, during which you will do the 
following: 
 
1. Supply your name and company as they should appear in the SUDAAN banner. 
 
2. Read and accept the SUDAAN license agreement. 
 
3. Accept the default target directory C:\Program Files\SUDAAN\Release90x (recommended) or specify 

a different directory where SUDAAN should be installed.  
 
4. As illustrated in Figure 1.1, you will be asked to check all versions of SUDAAN that you wish to 

install. Refer to subsequent sections of this Installation Guide for detailed instructions on installing 
each version.  Note that if you have purchased more than one license to SUDAAN (e.g. Standalone 
and SAS-Callable Indiv User), then all versions can be installed simultaneously by checking the 
corresponding boxes at this screen. 

 
Figure 1.1  Selecting Versions of SUDAAN During Installation 

 
 

1.3 SUDAAN Help  
 
SUDAAN’s Interactive Help system is easily accessible from within SUDAAN by Selecting Help from 
the Main Menu, or from the SUDAAN folder on the Start Programs menu.  
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The SUDAAN Interactive Help is also available at SUDAAN’s website: http://www.rti.org/sudaan.  
Click on Technical Assistance, then On-line Help.  
 
Please note that not all features of the compiled HTML help (the file is called SUDAAN.CHM) work 
properly under Windows 95 and Windows 98. Use the HTML help from our website by visiting the 
Downloads page to download the HTML help files to your computer. 
 

1.4 SUDAAN Manual 
 
The SUDAAN Language Manual the SUDAAN Example Manual will be installed by default in the 
manual subdirectory of SUDAAN\Release90x and shortcuts to these documents will be located in the 
SUDAAN folder on the Start Programs menu. Additionally, the Windows User’s Guide (for Standalone 
SUDAAN only) will be installed by default in the SUDAAN\Release90x directory and a shortcut to this 
document will also be placed in the SUDAAN folder on the Start Programs menu.  All of these files are in 
PDF format. Use Adobe Acrobat Reader, which is avfcailable free from Adobe’s website to view these 
documents. You can find additional SUDAAN examples on our website.  

1.5 Procedure to Renew a SUDAAN License 
 
Unless you have obtained a permanent license to this release of SUDAAN, you will need to renew your 
SUDAAN license in order to continue using the software after the expiration date. Once you have 
purchased the renewal, you will receive a new 22-digit Product Key for each version of SUDAAN that 
you have an annual license to. To update your software, do the following: 
 

1. For Windows XP, 2000, or NT, make sure that you are logged in to your computer with 
administrator privileges. 

 
2. Click on the shortcut to SUDRENEWAL.EXE in the SUDAAN folder on the Start Programs 

menu.  
 
3. Enter your name and company as they should appear in the SUDAAN banner, and your new 

22-digit product key 
 
4. The renewal software will ask you for the location for the SUDAAN.EXP file.  By default, 

this will be located under 
 
 Directory Location of SUDAAN.EXP SUDAAN Version 
 Program Files\SUDAAN\Release90x\DOS For DOS Version 
 Program Files\SUDAAN\Release90x\WinInd For Standlone Individual User Version 
 Program Files\SUDAAN\Release90x\WinNet For Standalone LAN User Version 
 Program Files\SUDAAN\Release90x\SAS8Ind For SAS8 Callable Individual User Version 
 Program Files\SUDAAN\Release90x\SAS8Net For SAS8 Callable LAN User Version 
 Program Files\SUDAAN\Release90x\SAS9Ind For SAS9 Callable Individual User Version 
 Program Files\SUDAAN\Release90x\SAS9Net For SAS9 Callable LAN User Version 

 
Figure 1.2 illustrates the box that will appear when the renewal software asks for the location 
of your SUDAAN.EXP file.  Note that you should select the directory location of your 
SUDAAN.EXP on the left side of this box, and select the SUDAAN.EXP file on the right.  
The OK button at the bottom of this box will not appear until the SUDAAN.EXP file is 
selected with a mouse-click. 
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Figure 1.2  Selecting the SUDAAN.EXP File During the SUDAAN Renewal Process 

 
 
 
At this point your software is updated, and you can continue to use it. 
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2. INSTALLATION INSTRUCTIONS FOR DOS STANDALONE, 
INDIVIDUAL USER VERSION   

 

2.1 System Requirements 
 
Category Requirement 
Computer 486 or better PC Compatible  
Resources 8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 95 and above  
 

2.2 Software Installation 
 
1. Select DOS as the setup type by clicking on the check box to the left of this type in the left pane of 

the setup window as shown in Figure 2.1 below.  Note that you will need to page down in the left-
hand pane to locate the DOS version. 

 
Figure 2.1: Installing the DOS Individual Version of SUDAAN 

 
 

By default, the following components will be installed.  However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are displayed in 
the right pane of the setup window. 

 
Component  Description 
Program Files   Files required to execute SUDAAN procedures 
Language Manual SUDAAN Language Manual in Adobe Acrobat .PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat .PDF format 
 

2. Confirm your selections. 
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3. Enter your 22-digit product key. This key is located on the attached letter that was sent to you with 

this CD. Make sure the product key is for the DOS Standalone Individual User version of SUDAAN.  
 

 IMPORTANT:  Be sure to save this product key, since you will need it again whenever you 
have to reinstall the software, for example on a new computer. You will also 
need this product key for renewing an annual license to SUDAAN. 

 
Following installation, the following subdirectories and files should be present (by default under 
C:\Program Files, or in the installation directory you have specified during setup) 
 

• SUDAAN\Release90x  
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files. 

 
• SUDAAN\Release90x\DOS  

This subdirectory will contain all program and other required files. 

   
• SUDAAN\Release90x\Help 

This subdirectory will always be present, and contains the CHM Help. Note that SETUP will 
create a shortcut to it in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release90x\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual, 
and/or the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents 
in the SUDAAN folder on the Start Programs Menu. 

 
The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN program, the SUDAAN website, SUDAAN Language and Example Manuals, Windows User’s 
Guide, SUDAAN Help, and the SUDRENEWAL program. 
 

2.3 Running SUDAAN  
 
After installation, you will need to add your new SUDAAN directory, by default  
 
 <path>\SUDAAN\Release90x\DOS,  
 
to your directory PATH.  <path> is the complete path specification for the SUDAAN programs, which by 
default is C:\Progra~1.  Remove any old SUDAAN directory from the PATH.  If you make these changes 
in your system settings, they will be available each time you boot your system.   
 
The syntax for executing SUDAAN (from the DOS Command prompt, or from the RUN command) is: 
 
 SUDPROC infile [outfile] [-r | -a] 
 
where infile is the name of the file containing SUDAAN procedure statements, outfile is the name of the 
file to which you should direct outputs, and r and a are write options. 
 
IF outfile already exists... 
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 -r causes the file to be overwritten, and 
 -a causes the output to be appended to the existing file 

 
See the SUDAAN Language Manual and the SUDAAN Example Manual for complete information on 
using the SUDAAN procedures. 
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3. INSTALLATION INSTRUCTIONS FOR WINDOWS 
STANDALONE INDIVIDUAL USER VERSION   

 

3.1 System Requirements 
 
Category Requirement 
Computer 486 or better PC Compatible  
Resources 8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 95 and above  
 

3.2 Software Installation 
 
1. Select Standalone Indiv. User as the setup type by clicking on the check box to the left of this type 

in the left pane of the setup window as shown in Figure 3.1 below. 
 

Figure 3.1: Installing Standalone Individual User SUDAAN 

 
 

By default, the following components will be installed. However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are displayed in 
the right pane of the setup window. 

 
Component Description 
Program Files  Files required to execute SUDAAN procedures 
Language Manual SUDAAN Language Manual in Adobe Acrobat .PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat .PDF format 
Windows User’s Guide A User’s Guide for the Standalone Windows Version 

 
2. Confirm your selections. 
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3. Enter your 22-digit product key. This key is located on the attached letter that was sent to you with 

this CD. Make sure the product key is for the Standalone Individual User version of SUDAAN.  
 

IMPORTANT:  Be sure to save this product key, since you will need it again whenever you have 
to reinstall the software, for example on a new computer. You will also need this 
product key for renewing an annual license to SUDAAN. 

 
Following installation, the following subdirectories and files should be present (by default under 
C:\Program Files, or in the installation directory you have specified during setup) 
 

• SUDAAN\Release90x  
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files as 
well as the Windows User’s Guide.  Note that SETUP will create a shortcut to this document in 
the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release90x\WinInd  

This subdirectory will contain all program and other required files.  

 
• SUDAAN\Release90x\Help 

This subdirectory will always be present, and contains the CHM Help. Note that SETUP will 
create a shortcut to it in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release90x\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual, 
and/or the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents 
in the SUDAAN folder on the Start Programs Menu. 

 
The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN program, the SUDAAN website, SUDAAN Language and Example Manuals, Windows User’s 
Guide, SUDAAN Help, and the SUDRENEWAL program. 
 

3.3 Running SUDAAN  
 
Please refer to the Windows User’s Guide for complete details on how to run Windows Standalone 
Individual User SUDAAN.  
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4. INSTALLATION INSTRUCTIONS FOR WINDOWS 
STANDALONE NETWORK  

 
All LAN versions of SUDAAN should be installed using a two-step process: 
 
 1. Install the Administrator version of SUDAAN from the CD as described in Section 4.2. 
 
 2. Each user wishing to use SUDAAN on the LAN must complete the LAN User Version 

installation as described in Section 4.3.  All files needed for the LAN User Version installation 
will be installed during the LAN Administrator Version installation.   

 
IMPORTANT: As indicated in the SUDAAN license agreement, the maximum number of 

simultaneous users who access SUDAAN on the network should not exceed the total 
number of users associated with your SUDAAN LAN license. 

 

4.1 System Requirements 
 
Category Requirement 
Computer 486 or better PC Compatible  
Resources 8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 95 and above  
 

4.2 Software Installation–LAN Administrator 
 
1. Select Standalone Network as the setup type by clicking on the check box to the left of this type in 

the left pane of the setup window as shown in Figure 4.1 below. Note that you may need to scroll 
down to see this version on the setup window. 

 
Figure 4.1: Installing Standalone Network SUDAAN 
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By default, the following components will be installed. However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are displayed in 
the right pane of the setup window. 

 
Component Description 
Program Files  Files required to execute SUDAAN procedures 
NetUser Setup Files SETUP.EXE and other files for network user install (See Section 4.3) 
Language Manual SUDAAN Language Manual in Adobe Acrobat .PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat .PDF format 
Windows User’s Guide A User’s Guide for the Standalone Windows Version 

 
2. Confirm your selections. 
 
3. Enter your 22-digit product key. This key is located on the attached letter that was sent to you with 

this CD. Make sure the product key is for the Standalone Network version of SUDAAN.  
 

IMPORTANT:  Be sure to save this product key, since you will need it again whenever you 
have to reinstall the software, for example on a new computer. You will also 
need this product key for renewing an annual license to SUDAAN. 

 
Following installation, the following subdirectories and files should be present (by default under 
C:\Program Files, or in the installation directory you have specified during setup) 
 

• SUDAAN\Release90x  
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files. 
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files as 
well as the Windows User’s Guide.  Note that SETUP will create a shortcut to this document in 
the SUDAAN folder on the Start Programs Menu. 

  
• SUDAAN\Release90x\WinNet 

This subdirectory will contain all program and other required files. 
 

• SUDAAN\Release90x\WinNet\NetUser 
This subdirectory will contain SETUP.EXE and other files required for the network user install 

 
• SUDAAN\Release90x\Help 

This subdirectory will always be present, and contains the CHM Help. Note that SETUP will 
create a shortcut to it in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release90x\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual, 
and/or the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents 
in the SUDAAN folder on the Start Programs Menu. 

 
The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN program, the SUDAAN website, SUDAAN Language and Example Manuals, Windows User’s 
Guide, SUDAAN Help, and the SUDRENEWAL program. 
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4.3 Software Installation–LAN User 
 
The SETUP.EXE program in the NetUser subdirectory of the SUDAAN\Release90x\WinNet network 
directory is a program that will automatically set up SUDAAN for each user. This program should be run 
by each user.  After SETUP has run, verify that SETUP has created a SUDAAN folder in the Start 
Programs menu. In the folder one should find shortcuts to the SUDAAN program, the SUDAAN website, 
SUDAAN Language and Example Manuals, the Windows User’s Guide, and the SUDAAN Help.  
 

4.4 Running SUDAAN  
 
Please refer to the Windows User’s Guide for complete details on how to run Windows Standalone 
Individual User SUDAAN.  
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5. SUDAAN WINDOWS USERS GUIDE 
 
This guide will introduce you to the special features of the Standalone Windows Version of SUDAAN 
(Individual or LAN version). You can execute this version in either interactive or batch mode. Section 5.1 
describes the SUDAAN interface available to you when you run in interactive mode. Section 5.2 
describes how to use SUDAAN in batch mode. 
 

5.1 Using Interactive SUDAAN 
 
To launch an interactive session of SUDAAN for Windows, click on the 
Start button on your Windows Desktop (generally in the lower left 
corner), choose Programs or All Programs, and then click on the 
SUDAAN icon. You may also locate the SUDAAN executable, 
WSUDAAN.EXE in the Windows Explorer and double click on the icon 
to execute SUDAAN as shown in Figure 5.1. 
 
5.1.1 Main Menu 
 
SUDAAN’s interface (Figure 5.2) displays two windows: the Input window and the Output window. The 
Input window is a text editor in which you can create or edit SUDAAN programs; the Output window is a 
read-only viewer used to display the results 
from SUDAAN runs. You can switch from the 
Input window to the Output window by simply 
clicking in the Output window area, and vice 
versa. 
 
The SUDAAN interface has a single main 
menu bar at the top of the screen for both Input 
and Output windows as shown in Figure 5.2. 
From this menu, you can edit and save your 
SUDAAN programs, execute, display and save 
SUDAAN results, access font selection and 
data directories options, and get online help 
resources. These options are discussed in the 
next several sections. 
 
5.1.2 File Menu Option 
 
From the Input window, you can open an 
existing SUDAAN program by selecting Open 
from the File menu, or you can select New to 
create a new program from scratch. Note that the capacity of the Input window is 32KB under Windows 
’95 and ’98. The capacity of the Input window under Windows NT, 2000 and XP is 2GB. 
 
From either window you can choose Save or Save as to save the contents of the window and you can 
choose Print to print the contents of the window.  
 
Figure 5.3 and Figure 5.4 illustrate the Open and Save screens in SUDAAN. 

Figure 5.1: SUDAAN for 
Windows Icon 

 

Figure 5.2: SUDAAN Input and Output Windows 
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5.1.3 Edit Menu Option 
 
The Edit option from the menu bar provides the standard Undo, Cut, Copy, Paste and Select All 
functions for the Input window. You can select these functions using either the mouse or the key 
accelerators.  Selecting Clear from the Edit menu 
will clear everything in the Input window; anything 
unsaved will be lost. 
 
The only available selection in the Edit Menu for the 
Output window is Clear, since it is a read-only 
viewer.  You can save the output to a file and then 
edit it using another editor, for example, NotePad. 
 
Figure 5.5 illustrates the Edit screen in SUDAAN 
associated with the Input window. 
 
 
5.1.4 Option Menu Option 
 
Selecting Option from the menu bar will allow you 
to change the default directory and change the font 
for both viewing and printing. This is depicted in 
Figure 5.6. 
 

Figure 5.3: File Popup Menu for  
Input Window 

 

Figure 5.4: File Popup Menu for 
Output Window 

 
 

Figure 5.5: Edit Popup Menu from  
Input Window 
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You can set the Data Directory for your SUDAAN data files by selecting DataDir... from the Option 
menu.  After selection, a dialog box will appear as depicted in Figure 5.7. 
 
NOTE:  If you don’t specify a full path name in the DATA= option on the PROC statement of your 
SUDAAN program or the FILENAME= option on the PRINT and OUTPUT statements, SUDAAN will 
assume the data is in the directory specified in DataDir... on the Option menu. The default Data 
Directory is the directory where the SUDAAN program is located.  
 
Once you set this directory, SUDAAN saves it in a SUDAAN.INI file for future use. SUDAAN will 
continue to use this Data Directory for both interactive and batch mode until you change it. The 
SUDAAN.INI file in your Windows directory has several sections. You should not attempt to modify this 
file. The sections entitled [DATA DIRECTORY] and [FILE DIRECTORY] in SUDAAN.INI are used to 
store the currently selected values for these directories. DataDir= and FileDir= are reserved case 
sensitive keywords in SUDAAN.INI which you should never change. DataDir is used to keep track of 
your Data Directory settings. You should change the Data Directory setting only by choosing the 
DataDir... option from the Option menu. FileDir is used to initialize the current working directory for 
SUDAAN and should never be changed. 
 
The Font… option is available from both Input and Output windows. Select Font from the Option Menu 
to specify the font type and font size for both viewing and printing. You can select different fonts for the 
Input and Output windows. The Courier or Courier New font is suggested for the Output window, since it 
is a monospaced font. 
 
5.1.5 Execute Command 
 
Click Execute! on the menu bar or press the F3 key, to execute the program in the Input window. The 
results are displayed in the Output window. Use the cursor keys to navigate within the Output window.  
 

Figure 5.7: Data Dir... Option Dialog Box 

 

Figure 5.6: Option Popup Menu 
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Please note the following: 
 
¦  If you don’t clear the Output window following execution, the results from subsequent runs will be 

appended to it.  
 
¦  SUDAAN saves all output from the current program in the file SUDAAN.OUT in the same directory 

with the SUDAAN executable. In cases where no output appears in your Output window because of 
an error, check this file to determine the possible cause of problems. 

 
5.1.6 Window Menu Option 
 
The Window menu option (Figure 5.8) provides utilities for Cascade, Tile Horizontal and Tile 
Vertical. The active window (either Input or Output) is checked. You can switch from Input window to 
Output window by selecting Output from the Window menu, and vice versa. 
 
5.1.7 Help Menu Option 
 
Help on the menu bar links to a complete online reference for all SUDAAN features and utilities. The 
Help menu has the following options (see Figure 5.9): 
 
¦  Contents:  (F1) links to the Help facility with Contents displayed in the left pane. SUDAAN Help is 

a compiled HTML (.CHM) file which can be accessed either from the Help menu on SUDAAN’s 
main menu, or directly from the Windows Explorer.  

 
¦  Search for help on..:  Links to the Help facility with the Keyword Search dialog displayed in the left 

pane. 
 

Figure 5.8: Window Popup Menu 

 
 

Figure 5.9: Help Popup Menu 
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¦  Index: Links to the Help facility with the index tab displayed in the left pane. 
 
¦  About SUDAAN For Windows: Displays the SUDAAN release number as well as your license 

information. 
 
5.1.8 The Right Mouse Button Options 
 
Click the right mouse button in either the input or output window and then select different options using 
the left mouse button. The options are a subset of those on the SUDAAN main menu. See Figure 5.10 
and Figure 5.11 for an example. 
 

 
 

5.2 How to Execute SUDAAN in Batch Mode 
 
The complete command line syntax to run SUDAAN in batch mode is: 
 

<path>WSUDAAN.EXE [infile] [outfile] [-r | -a] 
 
where: 
 
 path is the complete path specification for the SUDAAN executable 
 
 infile is the complete file specification for the file containing your SUDAAN program. If this 

option is omitted, an interactive session of SUDAAN is launched 
 
 outfile is the name of the file where output should be directed. If this option is omitted, SUDAAN 

will direct output to a file with the same directory location and name as infile, but with extension 
“.OUT”. If the outfile already exists, and no write option is specified, SUDAAN will display a 
dialog box to confirm that you want to overwrite the existing file. 

Figure 5.10: Right Mouse Menu 
from Input Window 

 

Figure 5.11: Right Mouse Menu 
from Output Window 
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 -r | -a is the write option. The option r indicates that SUDAAN should replace or overwrite an 

existing file of the same name in the same location. The option a indicates that SUDAAN should 
append new output to an existing file of the same name in the same location. 

 
If you don’t specify the full path name of the input data file using the DATA= option on the SUDAAN 
procedure statement, SUDAAN will assume the data is in the DataDir= variable of the [DATA 
DIRECTORY] section of the SUDAAN.INI file. If the data is not in the specified directory, there will be 
an error message in the SUDAAN output file. When the SUDAAN batch job starts to run, the following 
message box will appear (Figure 5.12) then automatically disappear when the job is completed. 
 

Figure 5.12: SUDAAN Job is Running Message 

 
 
 
SUDAAN can be run in batch mode using the following methods: 
 
1. Choose Run from the Start menu in Windows and type in the desired WSUDAAN.EXE 

command line. 
 
2. Select Command Prompt from the Start menu in Windows (sometimes located under All 

Programs and then Accessories) and type in the desired WSUDAAN.EXE command line. 
 
3. The WSUDAAN.EXE command line can be put in a typical .BAT file and executed accordingly. 
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6. INSTALLATION INSTRUCTIONS FOR SAS-CALLABLE 
INDIVIDUAL USER VERSION  

 
SAS-Callable SUDAAN users are permitted to install SUDAAN SAS8-Callable, SUDAAN SAS9-
Callable or both versions for each licensed user. So one user may have both SUDAAN SAS8-Callable 
and SUDAAN SAS9-Callable on their machines at the same time and this will count as only “one user” 
for license purposes.  SUDAAN requires users of SAS8 and SAS9 to go through separate installations 
only because the files needed to run SUDAAN are slightly different to accommodate differences between 
SAS8 and SAS9. 
 
Note that SUDAAN SAS8-Callable will run under Windows 95 and above however SUDAAN SAS9-
Callable will only run under Windows NT, 2000 and XP. 
 
The following instructions apply to both the installation of SUDAAN for SAS8 and SAS9.  Unless 
otherwise noted, the “#” character in these instructions should be interpreted as an “8” for SUDAAN 
SAS8 installations or as a “9” for SUDAAN SAS9 installations.   
 

6.1 System Requirements 
 
Category Requirement 
Computer 486 or better PC Compatible  
Resources 8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 95 and above (for SUDAAN SAS8-Callable) 
 Microsoft Windows NT, 2000 or XP (for SUDAAN SAS9 Callable) 
Software  SAS® 8 for Windows or SAS® 9 for Windows 
 

6.2 Software Installation 
 
1. Select SAS#-Callable Indiv. User as the setup type by clicking on the check box to the left of this 

type in the left pane of the setup window as shown in Figure 6.1 below.  Users wishing to install 
SUDAAN SAS8-Callable and SUDAAN SAS9-Callable can install these versions of SUDAAN 
concurrently by selecting all the desired boxes in Figure 6.1. 
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Figure 6.1: Installing SAS8-Callable Individual User SUDAAN 

 
 
By default, the following components will be installed. However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are 
displayed in the right pane of the setup window. 

 
Component  Description 
Program Files   Files required to execute SUDAAN procedures 
HTML Help Files SUDAAN online help, callable from SAS 
CHM Help File Compiled Help file 
Language Manual SUDAAN Language Manual in Adobe Acrobat .PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat .PDF format 

 
2. Confirm your selections. 

 
3. If you are installing SUDAAN SAS9-Callable, the installation will present the question “Are all 

SAS9-Callable SUDAAN users working with SAS 9.1 or above?”  A response is needed to this 
question because SAS Version 9.0 requires different files from SUDAAN than SAS Version 9.1 or 
above.  This question will not be displayed during the SUDAAN setup if you are only installing 
SUDAAN SAS8-Callable. 

 
4. Enter your 22-digit product key. This key is located on the attached letter that was sent to you with 

this CD.  Make sure the product key is for the SAS-Callable, Individual User version of SUDAAN.  
 

 IMPORTANT:  Be sure to save this product key, since you will need it again whenever you 
have to reinstall the software, for example on a new computer. You will also 
need this product key for renewing an annual license to SUDAAN. 

 
5. Supply the directory location of your default SAS configuration file (SASV8.CFG or SASV9.CFG). 

Setup will display the correct path for you if SAS is installed in the default locations. If you are not 
sure where the SASV#.CFG are, or you want to override the default location, you can use the Browse 
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option provided by SETUP, or you can choose Find from the Start menu, and search for the file in the 
Windows Explorer. If SETUP locates the file, it creates a backup copy, named SASV#.BK0 before 
making changes in the SASV#.CFG file. SETUP makes the following changes to the file: 

 
• If you have specified installation of HTML Help files, then SETUP inserts the following line 

at the beginning of the SASV#.CFG file. By default: 
 

-HELPREGISTER 'SUDAAN Help' 'C:\Program Files\SUDAAN\Release90x\HELP\sudaan.htm' 
 

• SETUP inserts a line within the –PATH command at the end of the SASV#.CFG file 
pointing to the location of your SUDAAN program files. By default: 

 
 ‘C:\Program Files\SUDAAN\Release90x\SAS#Ind’ 

 
If the default SASV#.CFG contains only a –CONFIG command pointing to a complete SASV#.CFG file 
in another location, the install will update the second SASV#.CFG file. 
 
IMPORTANT: SAS will not be able to find your SUDAAN .DLL and HTML Help files without these 

changes to your SASV#.CFG. If you have multiple SASV#.CFG files on your 
computer (both local and network drives), check to make sure that you have specified 
the default SAS configuration file within SETUP and that you manually update the 
remaining SASV#.CFG files you will be using with SUDAAN. 

 
Following a default installation, the following subdirectories and files should be present (by default under 
C:\Program Files, or in the installation directory you have specified during setup) 
 

• SUDAAN\Release90x  
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files. 

 
• SUDAAN\Release90x\SAS#Ind  

This subdirectory will contain all program and other required files. 
 

• SUDAAN\Release90x\Help 
This subdirectory will be present if you specify installation of either HTML or CHM Help during 
the installation process. Note that if you specify installation of CHM Help, then SETUP will 
create a shortcut to it in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release90x\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual or 
the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents in the 
SUDAAN folder on the Start Programs Menu. 

 
The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN website, SUDAAN Language and Example Manuals, SUDAAN Help, and the 
SUDRENEWAL program. 
 
IMPORTANT: The SETUP program copies MSVCRT.DLL to your Windows System directory if it is 

not currently present. SUDAAN will not run properly without this DLL file.  
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6.3 Running SUDAAN  
 
You can run SUDAAN jobs in either SAS’s interactive mode or in batch mode. You should execute 
SUDAAN procedures just like any other SAS procedures in either mode. NOTE: Some SUDAAN syntax 
has been changed for this SAS-Callable version. Please refer to the SUDAAN Language Manual for 
details. See the SAS User’s Manual for information on how to run SAS jobs. The example illustrated in 
Figure 6.2 shows how to run the SURVIVAL procedure in interactive SAS. 
 

Figure 6.2: Running SUDAAN programs in SAS 8 
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7. INSTALLATION INSTRUCTIONS FOR SAS-CALLABLE 
NETWORK 

 
All SAS-Callable, LAN versions of SUDAAN should be installed using a two-step process: 
 
 1. Install the Administrator version of SUDAAN SAS8-Callable and/or SUDAAN SAS9-Callable 

from the CD as described in Section 7.2. 
 
 2. Each user wishing to use SUDAAN on the LAN must complete the LAN User Version 

installation as described in Section 7.3.  All files needed for the LAN User Version installation 
will be installed during the LAN Administrator Version installation. 

 
IMPORTANT: As indicated in the SUDAAN license agreement, the maximum number of 

simultaneous users who access SUDAAN on the network should not exceed the total 
number of users associated with your SUDAAN LAN license. 

 
SAS-Callable SUDAAN users are permitted to install SUDAAN SAS8-Callable, SUDAAN SAS9-
Callable or both versions for each licensed user. So one user may have both SUDAAN SAS8-Callable 
and SUDAAN SAS9-Callable on their machines at the same time and this will count as only “one user” 
for license purposes.  SUDAAN requires both the LAN administrator and the SUDAAN user(s) of SAS8 
and SAS9 to go through separate installations only because the files needed to run SUDAAN are slightly 
different to accommodate differences between SAS8 and SAS9. 
 
Note that SUDAAN SAS8-Callable will run under Windows 95 and above however SUDAAN SAS9-
Callable will only run under Windows NT, 2000 and XP. 
 
The following instructions apply to both the installation SUDAAN for SAS8 and SAS9.  Unless 
otherwise noted, the “#” character in these instructions should be interpreted as an “8” for SUDAAN 
SAS8 installations or as a “9” for SUDAAN SAS9 installations.   
 

7.1 System Requirements 
 
Category  Requirement 
Computer  486 or better PC Compatible  
Resources  8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 95 and above (for SUDAAN SAS8-Callable) 
 Microsoft Windows NT, 2000 or XP (for SUDAAN SAS9 Callable) 
Software  SAS® 8 for Windows or SAS® 9 for Windows 
 

7.2 Software Installation–LAN Administrator 
 
1. Select SAS#-Callable Network as the setup type by clicking on the check box to the left of this type 

in the left pane of the setup window as shown in Figure 7.1 below. Administrators wishing to install 
SUDAAN SAS8-Callable and SUDAAN SAS9-Callable can install these versions of SUDAAN 
concurrently by selecting all the desired boxes in Figure 7.1. 
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Figure 7.1: Installing SAS8-Callable Network SUDAAN 

 
 

By default, the following components will be installed. However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are displayed in 
the right pane of the setup window. 
 
Component Description 
Program Files  Files required to execute SUDAAN procedures 
HTML Help Files SUDAAN online help, callable from SAS 
CHM Help File Compiled Help file 
NetUser Setup Files SETUP.EXE and other files for network user install.  (See Section 7.3)  
Language Manual SUDAAN Language Manual in Adobe Acrobat .PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat .PDF format 

 
2. Confirm your selections. 

 
3. If you are installing SUDAAN SAS9-Callable, the installation will present the question “Are all 

SAS9-Callable SUDAAN users working with SAS 9.1 or above?” A response is needed to this 
question because SAS Version 9.0 requires different files from SUDAAN than SAS Version 9.1 or 
above.  This question will not be displayed during the SUDAAN setup if you are only installing 
SUDAAN SAS8-Callable. 

 
4. Enter your 22-digit product key. This key is located on the attached letter that was sent to you with 

this CD. Make sure the product key is for the SAS-Callable Network version of SUDAAN.  
 
 IMPORTANT:  Be sure to save this product key, since you will need it again whenever you have to 

reinstall the software, for example on a new computer. You will also need this 
product key for renewing an annual license to SUDAAN. 

 
5. Supply the directory location of your default SAS configuration file (SASV#.CFG). Setup will 

display the correct path for you if SAS is installed in the default location. If you are not sure where 
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the file is, or you want to override the default location, you can use the Browse option provided by 
SETUP, or you can choose Find from the Start menu, and search for the file in the Windows 
Explorer. If SETUP locates the file, it creates a backup copy, named SASV#.BK0 before making 
changes in the SASV#.CFG file. SETUP makes the following changes to the file: 

 
• If you have specified installation of HTML Help files, then SETUP inserts the following line 

at the beginning of the SASV#.CFG file. By default: 
 

-HELPREGISTER 'SUDAAN Help' 'C:\Program Files\SUDAAN\Release90x\HELP\sudaan.htm'  
 

• SETUP inserts a line within the –PATH command at the end of the SASV#.CFG file 
pointing to the location of your SUDAAN program files. By default: 

 
 ‘C:\Program Files\SUDAAN\Release90x\SAS#Net’ 
 
If the default SASV#.CFG contains only a –CONFIG command pointing to a complete SASV#.CFG file 
in another location, the install will update the second SASV#.CFG file. 
 
IMPORTANT: SAS will not be able to find your SUDAAN .DLL and HTML Help files without these 

changes to your SASV#.CFG. If you have multiple SASV#.CFG files on your 
computer (both local and network drives), check to make sure that you have specified 
the default SAS configuration file within SETUP and that you manually update the 
remaining SASV#.CFG files you will be using with SUDAAN. 

 
Following a default installation, the following subdirectories and files should be present (by default under 
C:\Program Files, or in the installation directory you have specified during setup) 
 

• SUDAAN\Release90x  
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files. 

 
• SUDAAN\Release90x\SAS#Net 

This subdirectory will contain all program and other required files. 
 

• SUDAAN\Release90x\SAS#Net\NetUser 
This subdirectory will contain the SETUP for all network users. 

 
• SUDAAN\Release90x\Help 

This subdirectory will be present if you specify installation of either HTML or CHM Help during 
the installation process. Note that if you specify installation of CHM Help, then SETUP will 
create a shortcut to it in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release90x\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual or 
the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents in the 
SUDAAN folder on the Start Programs Menu. 

 
The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN website, SUDAAN Language and Example Manuals, SUDAAN Help, and the 
SUDRENEWAL program. 
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IMPORTANT: The SETUP program copies MSVCRT.DLL to your Windows System directory if it is 
not currently present. SUDAAN will not run properly without this DLL file.  

 

7.3 Software Installation–LAN User 
 
The SETUP.EXE program in the NetUser subdirectory of the SUDAAN\Release90x\SAS#Net network 
directory is a program that will automatically setup SUDAAN for each user.  This program should be run 
by each user.  After SETUP has been run for each user, verify that the following steps have completed 
successfully.  
 
1. The MSVCRT.DLL file 

MSVCRT.DLL is required in the Windows System directory. SUDAAN will not work without this 
file. A copy of MSVCRT.DLL is supplied in the directory SUDAAN\Release90x\SAS#Net. Verify 
that a copy of this file is in the user’s Windows System directory. 

 
2. The SASV#.CFG file 

In order to use the SUDAAN interactive help system, the following line must appear at the beginning 
of the default SASV#.CFG file. (for example): 

 
-HELPREGISTER 'SUDAAN Help' 'M:SUDAAN\Release90x\Help\SUDAANHelp.HTML'  

 
where in this example the directory where SUDAAN files are located is 
M:\SUDAAN\Release90x. If your network administrator has installed the HTML help files, then 
verify the presence of this line. 
 
Also verify that the network path to SUDAAN is inserted into the –PATH command in the default 
SASV#.CFG file. This tells SAS where to find SUDAAN procedures. For example, if SUDAAN is 
installed at M:\SUDAAN\Release90x\SAS#Net, then the following line should be present: 

 
M:\SUDAAN\Release90x\SAS#Net 

 
in the –PATH command. This command is usually located at the end of the SASV#.CFG file. 

 
Note: If the default SASV#.CFG contains only a –CONFIG command pointing to a complete 
SASV#.CFG file in another location, the install will update the second SASV#.CFG file. 

 
If a user changes their network drive letter associated with SUDAAN, or if the directory where SUDAAN 
is located changes, then the user will need to make the corresponding changes in their SASV#.CFG file. 
 

7.4 Running SUDAAN  
 
SUDAAN jobs can be run in either SAS’s interactive mode or in batch mode. One should execute 
SUDAAN procedures just like any other SAS procedures in either mode. NOTE: Some SUDAAN syntax 
has been changed for this SAS-Callable version. Please refer to the SUDAAN Language Manual for 
details. See the SAS User’s Manual for information on how to run SAS jobs. The example illustrated in 
Figure 7.2 shows how to run the SURVIVAL procedure in interactive SAS. 
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Figure 7.2: Running SUDAAN programs in SAS 8 
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